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Personal Energy Audit: Teacher Guide 
 
In this activity your students will: 

1. Examine their energy use habits. 
2. Identify their high-energy consumption activities. 
3. Identify some energy consumption habits they can change to reduce their energy use. 

 
There are two versions of the Personal Energy Audit Spreadsheet and the Personal Energy Audit: The 
Spreadsheet Investigation Sheet.  
 
The Personal Energy Audit Spreadsheet Version 1 is a more detailed spreadsheet than Version 2.  
Version 1 requires more data input and may therefore take more time for students to complete in an 
instructional setting. In Version 1, students input all their energy use values. 
 
In Version 2, several items have been completed using typical household use values. These values 
include cleaning, heating, cooling, and transportation energy uses. If a student knows their energy use for 
a particular item that has a provided value, they may change it.   
 
In both spreadsheet versions, if students or members of their household do not participate in a particular 
energy use activity, instruct them to enter a “0” in Columns B and C on their spreadsheet for that row. 
 
The Personal Energy Audit: The Spreadsheet Investigation Sheet Version 2 has included cleaning, 
heating, cooling, and transportation values in a data table. These values are also included on the 
Personal Energy Audit Spreadsheet Version 2. 
 
Implementation suggestion: 
Select Version 1 or Version 2 based on the learning needs, capabilities of your students, and prior 
knowledge levels about personal and household energy use.  In an integrated classroom setting, you 
might wish to use both versions of the spreadsheet and the investigation sheet to differentiate instruction. 
 

Energy Basics/ Background Information 
 
We recommend that you review Energy Basics and Electricity Generation in the Support Materials 
section on Web site prior to beginning this activity. 
 
 
 

  Step 1: Download the energy audit spreadsheet. 
1. Have students go to the Students Resources Web page: www.ei.lehigh.edu/learners/energy 

 
2. Have students click on Energy Audit. 

The file, Audit.xls will appear on your students’ computer desktops. 
 

3. Have students double-click on the file to open it in Excel. 
Note:  If your students’ computers have the Numbers Spreadsheet application, the file will open in 
Numbers. 

 
Saving files 
1. From the top menu bar, have students select File -> Save As….  

 
2. Have students rename their files using the following format: Audit_intials.xls   

For example, if a student’s name is Diana Prince, she would save her file as Audit_DP.xls 
 

3. As students work on their audit, prompt them to re-save their file several times. 
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Step 2: Enter data in the energy audit spreadsheet. 
 
Below you will find detailed instructions about the use of the Spreadsheet.  Use these instructions as a 
reference as your students complete Audit 1.  Simplified directions are found on the student handout.   
 
The Energy Audit spreadsheet will look like this: 
 
Excel version: 

 
 
 
 
Numbers version: 
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1. Prompt students to think about the ways they use electricity.  

 
2. The spreadsheet lists common activities in Column A that use energy.   

 
3. Tell students they will provide their energy consumption information in Columns B and C.   
 

a. Prompt students to look at Column B (Hours Used).They will enter the number of hours they 
engage in the specific activities that are listed in Column A.    
 

b. Prompt students to look at Column C (Repeated Use).Have students think about how many 
“appliances” they run at a time.   

 
4. Model the following example: Look at row 6, Watch TV. Each evening in your house you watch 2 

hours of TV in your living room.  Your mom or dad might watch 2 hours of TV in the bedroom and 
your sister watches 2 hours of TV in the kitchen. Therefore, you have 2 hours of TV watching on 3 
different TV sets in your house each night.  

 
a. In this case, you would enter 2 in Column B (Hours Used) and enter 3 in Column C 

(Repeated Use) on your spreadsheet. 
 

b. The spreadsheet will automatically calculate your energy consumption in different units for 
watching TV for 2 hours on 3 different TV sets. See Columns F and I. 
 

c. Look at Columns K. The spreadsheet calculates how much money your energy consumption 
activity costs. For TV watching, Column K calculates your annual cost to be $36.14. 

 
 
 

  Step 3: Complete the spreadsheet. 
Below are detailed instructions about the use of the spreadsheet.  Use these instructions as a reference 
as your students complete Audit 1. Simplified directions and explanations of computations are found on 
the student handout.   
 
1. General Instructions 

a. Be sure you are entering data in the sheet labeled Audit 1. Look at the tabs on your spreadsheet.  
 
 

NOTE: Several spreadsheet columns are hidden to provide a less complicated view for your 
students. Columns hidden include: kW*h/day or week, Joules/ day or week, BTU/Day or 
week. If you choose to reveal these columns please complete the following steps.  
 

Excel directions: 
 Unprotect the workbook.  Tools>Protection>Unprotect Workbook. 
 Unprotect the sheet you wish to modify. Tools>Protection>Unprotect Sheet. 
 Highlight entire columns D through I on the spreadsheet.  

On a Macintosh computer – control-click and select Unhide.  
On a PC computer – Right-click and select Unhide. 

 
Numbers directions: 

 Select entire column across top by clicking and dragging the pointer across from 
column D to I.  Press control click and select unhide all columns. 
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Excel version: 
 

 
 

 
Numbers version: 
 

 
 

 
b. The spreadsheet is divided into two use categories: Everyday Activities and Weekly Activities.   

 
i. Everyday Activities include 6 areas: Entertainment, Communications, Personal Care, 

Lighting, Food Preparation, and Heating and Cooling. 
 

ii. Weekly Activities include Cleaning, Short Range Transportation and Long Range 
Transportation.  These are activities that use electricity or fuel.  The transportation sections 
of the spreadsheet converts fuel use into electrical energy equivalents. 
 

c. Have students think about how many hours they do each activity. Ask them to be honest.   
 

d. Tell students they will input data into columns B and C. The values for all other columns will 
automatically be generated. 
 

e. Tell students that if they or their household does not do a particular energy activity, enter 0 in 
both Columns B and C. 
 

f.  Daily Average: Some people complete activities in the daily section a few times a week 
rather than daily. Tell students to use the following formula if they do not do an “everyday activity” 
daily, but a few times during the week. 

 
 
 
 

 
i. Model the following example with your students: If you only charge your iPod a few hours a 

week you will need to figure out a daily average. For example, if you charge your iPod for 3 
hours in a week, your daily average is 3/7 = .43 hours 

 
g.  Time Increments: Have students use the following time increments for Column B if they 

do not do an activity for a full hour. For example, a student may take a shower for five minutes 
each day. In this case, tell students they would enter 0.083 (hour) in column B. 
 

 Time Increments 

Minutes 2 min. 5 min. 10 min. 15 min. 20 min. 30 min. 45 min. 

 Daily Average = Hours used / 7 days a week  
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Hour 
equivalent .033 .083 .167 .25 .33 .5 .75 

 
  

h.  Energy Vampire Alert: Some appliances or chargers use energy when they are not actively 
charging or are in stand-by mode waiting be activated by a remote or sensor. Tell students that if 
they see this icon to please think about their current habits before they fill in their hours used or 
repeated use values.  
 

i. Tell students that if they keep their iPod or MP3 player plugged in even when it is completely 
charged they must count this as charging time. Appliances with chargers use electricity even 
if the battery is completely charged. If they leave the charger plugged in after the appliance is 
removed it also uses some electricity, although not as much. 
 

ii. Tell students if their chargers or base stations remain plugged in all day, every day, they 
need to enter 24 hours in Column B. 
 

i. Remind students to SAVE their work. 
 
 

2. Entertainment 
Have students look at their energy consumption for their entertainment and recreation activities. Have 
students think about how many hours they participate in each of these activities. Consider using the 
following prompts below with your students. 

 
 Your students may need to calculate a daily average for items in this section.  

 
a. Look at Row 6. How many hours do you or members of your household watch TV each day? 

Think about how many TVs are usually turned on in your home. 
 

b. Look at Row 7 and 8. How long do you charge your iPod or MP3 player or hand-held video 
game each day? Do you charge your iPod or MP3 player daily when you download new music or 
play it in a dock? How long do you charge your hand held video games (PSP or Nintendo DS) 
each day?  
 

c. Look at Rows 9 and 10. How many hours do you watch play video games or DVDs or VHS tapes 
each week? Unless you have an integrated monitor you are using two appliances (Column C), 
the video game console or DVD player and the TV.  
 

d. Look at Row 11 and 12.   Think about how many hours you work on a desktop or laptop 
computer.   
 

i. If you do not turn off your computer, it is still using electricity. If so, enter “24” in Column B in 
Row 11. 
 

ii. If you always use your laptop when it is plugged in, it is always drawing electricity. If so, enter 
“24” in Column B in Row 12. 
 

e. Look at Row 13. Do you or members of the household play the radio? How long is your radio 
turned on each day? 
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3. Communications 
 Your students may need to calculate a daily average for items in this section. Consider using the 

following prompts below with your students. 
a. Look at Row 17 and 18.  How long do you charge your cell phone or cordless phone each 

day?  
 

i. If you keep you phone charger plugged in even when it is completely charged, it is always 
drawing electricity. If so, enter “24” in Column B in Row 17. 
 

ii. How many people in your house are charging their phones every day? If you have 3 phones 
being charged each day you should enter 3 in Column C. 

 
4. Personal Care 

 Your students may need to use the time increment table for items in this section to determine 
their entry for Column B if less than one hour. Consider using the following prompts below with 
your students. 
 
a. Look at Row 22. How much hot water do you or members of your household use each day?   

 
i. How long does it take for you to take a shower or fill a bathtub? How many times a day 

does someone in your house take a shower or a bath? 
 

ii. How many times a day does someone in your house take a shower or a bath?  Count each 
shower or bath as a repeated use.  
 

b. Look at Row 23. How long do you or members of your household use a hairdryer each day? 
 

c. Look at Row 24. How long do you or members of your household use a curling iron or 
straightening iron each day? 

 
5. Lighting 

Have students think about how many hours the lights are turned on both inside and outside their 
house each day. Consider using the following prompts below with your students.   
 
a. Look at Row 28. Do you use lights only when it is dark? Do you leave lights turned-on in your 

house even when you are not in a room? Do you have outside lights that remain on during the 
night? 
 

i. Total the number of hours that lights are on in your home each day. Enter this value in 
Column B.   
 

ii. How many lights are usually on at a time? For example, if you have three lights on in the 
living room, two lights on in a bedroom, and one in the kitchen, you would enter 6 in Column 
C. 
 

6. Food Preparation 
Have students think about how many hours they or members of their household participate in food 
preparation each day. Consider using the following prompts below with your students. 
 

 Your students may need to use the time increment table for items in this section to determine 
their entry for Column B if less than one hour.  

 
a. Look at Row 32 and 33. How much time do you or members of your household spend cooking on 

the stove?  Think about all the meals?  Do you cook on just one burner?  Count each burner as a 
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separate appliance (Column C). Think about how often you use the oven to bake, roast, or warm 
food. Is this done daily?   
 

b. Look at Row 34 and 35. Think about how often you use the microwave or toaster? A microwave 
is usually used it in small increments but several times a day.    
 

c. Look at Row 36. Your refrigerators and freezers are plugged-in 24 hours a day. Enter 24 in 
Column B. Do you have more than one refrigerator or freezer in your household? If your 
refrigerator and freezer are connected, count this as one refrigerator.  
 

d. Look at Row 37. Think about how often you wash dishes in your home.  Do you have a 
dishwasher? How long does it take to wash one load of dishes?  Enter this number in Column B.  
How many times a day does your dishwasher run? Enter this number in Column C. 

 
7. Heating and Cooling 

 Have students use the Seasonal Equivalent Chart for items in this section to determine their 
entry for Column B. Consider using the following prompts below with your students. 
 
a. Heating and Cooling: Think about how you heat and cool your home. Fans, air conditioners 

furnaces, and space heaters are frequently used seasonally. It is common to use them for only 3-
6 months a year. Some people use fans year round, others seasonally. Use the Seasonal Use 
Equivalent Chart below to determine your daily hours used. You will need to multiply your hours 
used daily when in season by the seasonal use factor below. 
 

 
 
 

 
 Seasonal Use Equivalent Chart 

Months used 3 months 4 months 5 months 6 months 9 months 12 months 

Seasonal Use 
Factor 
 

1/4 or .25 1/3 or .33 5/12 or .42 1/2 or .5 3/4 or .75 No 
Change 

 
i. For example the air conditioner is always on in your house for 24 hours each day during 3 

months of summer. Your seasonal use average is  
24 hours  X .25 = 6 
In this example, you would enter 6 in Column B. 

 
b. Look at Rows 41 and 42. Some people run floor and ceiling fans year round and others 

seasonally to circulate air. 
 

c. Look at Rows 43 and 44. Air conditioners are usually used only in warm weather seasons. 
 

i. If you live in a warm climate and use the air conditioning year round, you do not need to 
make an adjustment. 
 

d. Look at Row 45. Furnaces are usually used in cold seasons.  Some people only use them a few 
months a year.  
 

  

       Seasonal Use Average = Hours used per day  X Seasonal Use Factor 
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e. Look at Row 46. Some people use portable space heaters in addition to a furnace to heat rooms 
during the cold season.  
 

8. Cleaning 
Have students look at their use of energy consumption for their cleaning activities. Consider using the 
following prompts below with your students. 
 
a. Think about how many hours you or members of your household participate in each of these 

activities each week.  
 

i. Look at Row 52 and 53.  How often is the washing machine or dryer used each day?  Do you 
run more than one load a day? Count each load of laundry as  
1-hour use.  How many times a week do you run multiple loads?  For example, some homes 
have two laundry days. They run 4 loads, 2 times a week.  In this example, you would enter 
4 in column B and 2 in Column C. 
 

ii. Look at Row 54.  Do you or members of your household iron clothes?  It usually takes about 
5 minutes to iron a shirt.  How long is the iron on at a time?  How many times a week does 
this happen in your house?  

 Use the time increment table in Step 5, 1g to determine your entry for Column B if the 
weekly total is less than one hour. 
 

iii. Look at Row 55. How long does it take to vacuum all the rooms in your house? How many 
times a week does someone vacuum your house? 
 

9. Transportation 
Have students look at their use of energy consumption for their transportation activities. Consider 
using the following prompts below with your students. 
 
a. Short Range Transportation:  

 
i. Look at Row 59. Think about the number of trips you take in a car during an average week.  

How many miles do you travel each time?  
Enter the total miles you travel in one week in Column B.  
If you travel this much almost every week, enter 52 in Column C. 
 

ii. Look at Row 60 and 61. Think about the number trips you take in the on the school bus, 
bus, train or subway for commuting purposes during an average week.  How many miles 
do you travel each time?  
Enter the total miles in Column B.  
If you do this most weeks of the year enter 52 in Column C.   
 

b. Long Range Transportation: 
 

i. Look at Row 65, 66, and 67. How many trips do you take on a train or plane for a big trip to 
see family or for vacation? How many miles do you travel each time?  Enter the average 
miles for your trips (round trip) in Column B.  
Enter the number of trips per year in Column C.  For example, if you travel 2 times a year, 
enter “2” in Column C. 

 

 Step 4: Analyze the results. 
Instruct your students to analyze their energy use practices based on their individual Energy Audit 
Spreadsheet results. See Personal Energy Audit: The Spreadsheet Assessment for suggested 
answers. 


